
















































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































o VRAM SIMM UPGRADES 

Introduction The Macintosh Quadra 900 ships with 1 megabyte of 
video RAM (VRAM) standard. You may increase video 
RAM to 2 megabytes by installing four VRAM SIMMs. 

You must use 100 ns (or faster) VRAM SIMMs on the 
Macintosh Quadra 900. VRAM SIMMs with a slower 
rating will cause video timing problems. 

Table 5-1 indicates the amount of video RAM needed for 
various monitor sizes and pixel depth combinations. 

Monitor 
Macintosh 12-Inch Monochrome 
Macintosh 12-Inch RGB 
Apple High-Res RGB C13-Inch) 
Apple Macintosh Portrait Display 
Apple Two-Page Monochrome 
Macintosh 21-Inch Color 
16-Inch Color 
VGA 
Super VGA 
NTSC 
NTSC with convolution 
PAL 
PAL with convolution 

Number of colors or shades of gray 
1 MB VRAM 2 MB VRAM 
256 millions 
millions 
256 
256 
256 
256 
256 
256 
256 
256 
256 
256 
256 

millions 
millions 
256 
256 
256 
millions 
millions 
millions 
millions 
256 
millions 
millions 

Table 5-1 Video RAM Configurations for Monitor Size and Pixel Depth 
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Installation 
and Handling 

Configurations 

Macintosh Quadra 900 

To install the VRAM SIMMs, you must first remove the 
drive shelf and power supply. Instructions are in 
Section 2, Take-Apart. 

Note: Use the SIMM removal tool to remove VRAM 
SIMMs. See the You Oughta Know tab for instructions 
on using the removal tool. 

CAUTION: SIMMs are very susceptible to damage from 
ESD and skin acid. Handle only by the edges! 

To upgrade the VRAM to 2 MB, you must install four 
VRAM SIMMs (one upgrade kit in socket J3 and one in 
socket J4). Refer to Figure 5-2 for VRAM SIMM socket 
locations. 

VRAM 
Sockets 
Location 

Figure 5-2 VRAM SIMM Socket Locations 
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• Apple Technical Procedures 

Macintosh Quadra 900 

o CONTENTS 

Macintosh Quadra 900 

Illustrated Parts List 

1PL. 3 System Exploded View (Figure 1) 
1PL.5 Logic Board Components (Figure 2) 
1PL.6 Miscellaneous Items 

Note: The figures and lists in this section include all 
piece parts that you can purchase separately from Apple 
for the Macintosh Quadra 900, along with their part 
numbers. ADB input devices for Macintosh computers 
now have their own tab section. Please refer to 
Macintosh Family Technical Procedures for ADB input 
devices. The items listed in this section are the only 
parts available from Apple. Refer to your Apple Service 
Programs manual for prices. 
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) o SYSTEM EXPLODED VIEW (Figure 1) 

Hem Part No. Description 

1 076-0434 Main Housing Assembly (includes product label, NuBus 
slot covers, fan exhaust vent cover, and light pipe) 

2 076-0432 Cover, Fan Exhaust Vent (also included with main 
housing) 

3 590-0518 Cable, SCSI Device Select (for use with 661-1641) 
590-0790 Cable, SCSI Device Select (for use with 661-1636) 

4 444-6104 Screw, 6-32 x .25 
5 805-5106 Hard Drive Carrier (3.5- or 5.25-Inch) 
6 661-0474 Apple SuperDrive (1.4 MB floppy drive) 
7 805-5113 Apple SuperDrive Spacer (included in screw kit) 
8 705-0045 Switch, SCSI Device Select 
9 590-0515 Cable, Apple Su perDrive 

10 661-1641 HDA, 160 MB, 3.5-Inch (without carrier) 
661-1636 HDA, 400 MB, 3.5-Inch (without carrier) 

11 590-0517 Cable, HDA Power 
12 590-0528 Cable, SCSI (with terminator) 
13 630-6097 Drive Shelf Assembly (includes Velcro cable straps) 
14 462-4100 Screw, Metric 3.5 x .6 x .8 PNCR Rec 
15 815-6262 Side Cover Latch 
16 076-0436 Side Cover Assembly (includes NuBus card guides) II 

) 17 661-0664 Power Supply (includes fan) 
18 720-0518 Power Supply Fan 
19 462-4400 Screw, Metric 3.5 x 45 SEM Machine (included in 

screw kit) 
20 661-0665 Logic Board (without DRAM/VRAM SIMMs) 
21 420-1001 Screw, Metric 3.5 x .610, Self-Tapping (included in 

screw kit) 
22 815-6251 Light Pipe, Power LED (also included with main 

housing) 
23 462-4101 Screw, Metric 3.5 x 6, Pan-Head Machine (included in 

screw kit) 
24 630-6011 Speaker Assembly 
25 076-0433 Speaker Bezel Assembly 
26 825-1256 Apple Logo 
27 076-0431 Blank Bezel Assembly 
28 076-0437 Floppy Drive Bezel Assembly 
29 815-6249 Reset Actuator 
30 815-6250 Interrupt Actuator 
31 705-0175 Keyswitch (with two keys) 
32 590-0760 Cable, AC Power 
33 699-5073 Microphone Assembly 
34 590-0152 Cable, ADB, 2 Meter 

) 
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Figure 2 Logic Board Components 
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) o LOGIC BOARD COMPONENTS (Figure 2) 

Item Part No. Description 

1 742-0011 Lithium Battery 
2 520-0344 Battery Holder Cover 
3 661-0609 VRAM SIMM, 256K, 100 ns 

661-0722 VRAM SIMM, 256K, 80 ns II 
4 661-0520 DRAM SIMM, 1 MB, 80 ns 

661-0719 DRAM SIMM, 1 MB, 80 ns 
661-0546 DRAM SIMM, 1 MB, 80 ns, Parity 

5 517-0546 Jumper Connector (package of 10) 

) 

) 
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o MISCELLANEOUS ITEMS 

Part No. 

076-0439 
602-0282 
602-0210 
805-5050 
003-0003 
076-0435 

IPL.6/ Illustrated Parts List 

Description 

Dust Shield, 1.4 MB Apple SuperDrive, Package of 5 
Service Packaging, HDA, 3.5-Inch, Half-Height 
Service Packaging, 3.5-Inch Floppy Drives 
Shipping Fixture, Apple SuperDrive 
Packing Disk, Apple SuperDrive 
Miscellaneous Screw Kit 
Includes: 

420-1001 
462-4101 
462-4400 
805-5113 

Screw, Metric 3.5 x .610, Self-Tapping 
Screw, Metric 3.5 x 6, Pan-Head Machine 
Screw, Metric 3.5 x 45, SEM Machine 
Apple SuperDrive Spacer 
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Ii Apple Technical Procedures 

Macintosh Multiple-Product Diagnostics 

Technical Procedures 

o TABLE OF CONTENTS 

Section 1 -
MacTest MP 

Illustrated Parts List­
Apple TechStep 

M u Itiple-Product Diagnostics 

1.2 Introduction to MacTest MP 
1.2 Overview 
1.4 Features 
1.7 Starting MacTest MP 
1.7 Materials Required 
1.7 Test Setup 
1.8 Operating MacTest MP 
1.8 System Configuration Information 
1.9 Macintosh Test Selections 
1.11 Other Test Selections 
1.12 Setting Looping Options 
1.12 Setting Preferences 
1.13 Using the Controls 
1.14 As the Tests Are Running 
1.14 MacTest MP Reference 
1.14 Quick Reference 
1.15 Menus and Keyboard Equivalents 
1.18 System Software Compatibility 

IPL.3 Apple TechStep (Figure 1) 
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• Apple Technical Procedures 

Macintosh Multiple-Product Diagnostics 

Illustrated Parts List - Apple TechStep 

o CONTENTS 

Multiple-Product Diagnostics 

IPL.3 Apple TechStep (Figure 1) 

Note: The figures and lists in this section include all 
piece parts that you can purchase separately from Apple 
for Apple TechStep, along with part numbers. The items 
in this section are the only parts available from Apple. 
Refer to your Apple Seroice Programs manual for 
prices. 
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Figure 1 Apple TechStep 
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) 0 Apple TechStep (Figure 1) 
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1 
2 
3 

4 
5 

6 
7 
8 

Part No. 

699-0578 
076-0574 
590-0623 
076-0572 
076-0573 
661-0703 
077-8668 
B077-8668 
JA077-8668 
X077-8668 
Z077-8668 
590-4512 
590-0552 
590-4501 

Multiple-Product Diagnostics 

Description 

Carrying Case 
Port Pack 
Cable, SCSI 
ROM Pack, CPU Tests, Volume 1, v. 1.0 
ROM Pack, SCSI HD Tests, v. 1.0 
Assembly, Apple TechStep (without port or ROM packs) 
Power Adapter, U.S. 
Power Adapter, U.K. 
Power Adapter, Japan 
Power Adapter, Australia 
Power Adapter, Europe 
Cable, Stereo 
Cable, Mini DIN-8, 2-meter 
Cable, ADB, 2-meter 
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Section 1 - MacTest MP 

o CONTENTS 

1.2 Introduction to MacTest MP 
1.2 Overview 
1.4 Features 
1.7 Starting MacTest MP 
1.7 Materials Required 
1.7 Test Setup 
1.8 Operating MacTest MP 
1.8 System Configuration Information 
1.9 Macintosh Test Selections 
1.11 Other Test Selections 
1.12 Setting Looping Options 
1.12 Setting Preferences 
1.13 Using the Controls 

) 
1.14 As the Tests Are Running 
1.14 MacTest MP Reference 
1.14 Quick Reference 
1.15 Menus and Keyboard Equivalents 
1.18 System Software Compatibility 

) 
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o INTRODUCTION TO MACTEST MP 

Overview 

1.2/ MacTest MP 

MacTest™ MP is a disk-based confidence program that 
isolates and identifies faults in malfunctioning 
Macintosh fifx, Macintosh 1Isi, Macintosh LC, and 
Macintosh Classic® II computers. After completing 
repairs, use the program to verify proper system 
operation. 

In addition, use MacTest MP with any Macintosh II 
family computer to test the following Apple peripherals 
and monitors: 

• Internal and external floppy disk drives 
• Apple monitors (adjustment test patterns) 
• Apple video cards 

MacTest MP does not test hard disk drives. To test a 
hard disk drive, use the MaCintosh Hard Disk Test. 
Procedures for using Macintosh Hard Disk Test are in 
Section 3, Diagnostics, in SCSI Hard Disk Drives 
Technical Procedures. 

IMPORT ANT: If your customer's Macintosh Ilfx or 
Macintosh /lsi contains a Macintosh Display Card 
8·24GC, you must remove 8·24GC INITs from the System 
Folder before running MacTest MP. Failure to remove 
8·24GC INITs from the System Folder will hang 
MacTest MP. 

The MacTest MP main window in Figure 3-1 includes 
the following functions: 

• Program controls 
• System configuration information 
• Logic board test selections 
• Other test selections (floppy drive, ADB 

communications, Apple expansion and video cards, 
and Apple monitors) 

• Testing status indicator 
• Test log indicator 
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Syste m lie rs : 7.0.1 

Apl)lelallc Yens: 56 

Qui clc D ray lie rs: 2.3 

Note: The arrangement of items within the main 
window will depend on the size of the monitor and the 
system to which the monitor is connected. 

MacTest rM MP 2.0 

S~stem tnJe: f'1Ic:; ntash I..C 

PIIf"itg: NDt Available 

ROM size: 

RAM size: 

512 KB 

2 MB 

PoW'er-en Ilours: 238 

ROM Yers: 67c.13fl 

CPU/FPU t!ne: 68020 

rideo Rft t1 Size: 256 K B Production Date: 2125/91 

Select Nacintosh Tes1s Select Other Tes1s 

Lo,ic 8ear~ 

~ Co mpo ne nt 1ests 

181 RAN 1est 

I8J SeriallooptJlck: 

~ Video RA M test 

Floppy Drioves 

~ Right 

D 

ADB Pert ------, 

~ Mouse 

Slot 1: 

BI V: f.' .... ~.:.:.:;jJ-(8) M> ni to r co n neeted to b ui lt - i n 'Ii deo 

Status: Press "St.rt" 10 begin YOlY Session. Test Log: 

Figure 3-1 Main Window for 12-lnch Monitor with Macintosh LC 

Multiple-Product Diagnostics 

Each time a test sequence runs, MacTest MP stores the 
results temporarily in a test log. By selecting 
(highlighting) the Log icon, you can display a window 
containing the contents of the current test log. You can 
save, print, and customize the test log in this window 
to include the name and address of the customer and the 
service center (see Setting Preferences under 
"Operating MacTest MPII). You can also open, add to (if 
the system configuration and tests selected are the 
same), and print saved test logs. 

Note: If you are unable to print an open Test Log, save 
the Test Log, reboot MacTest MP, and try printing the 
log again. 
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Features Figure 3-2. MacTest MP has the following features: 

• Easy-to-use program controls. The bar of icons 
along the top of the main window controls the 
operation of the diagnostic program (Start, Stop, and 
Pause) and includes three additional features: 

A Log icon, which when selected (highlighted) 
displays a log of the test in progress or just 
completed. You can print test logs, save them, 
and customize them with service center and 
customer data. 

A Looping icon, which when selected 
(highlighted) repeats the selected tests to find 
problems that occur intermittently or after a 
delay. 

A Question Mark icon, which provides assistance 
for some test failures. The Question Mark icon 
is gray except when it contains additional 
service information. 

MaclestTM MP 2.(] 

Syeiam VU8: 7.0.1 

ApplaT81 t van: tJot Opened 

quif~Dr8W' Yen: 2.2 

Syah .. iyp.: Hlcl01Deh Ilfx 

Parity: ~at AVllilable 

CPUJFPU tYPf: 68030 I 68882 

Video RAM Size: ~ot AYDilable 

ROM 8izl: 

gAM 8izl: 

512 KB 

4 MB 

PIlYer-on hllurs: C 

R(]N yenl: 67c.11fl 

Select Muintosh Tests 

L091C Board 

t8:I COmJllrent lest! 

~ AAH te~t 

~ ~rial1QQpback: 

flO, py Drives 

t8:I Right 

~ Left 

ADB Port ------, 

~ Nouse 

Produc1iol Date: 10/9/91 

Se1ect Other Te3U 

Slot 1: ~ Ms:::1n1Dshll Hlgh Resolut1on Y'10eD 
Card 

Slot 2: 

Slot ~: 

Slot 4: 

Slot 5: 

Slot 6: 

Tus=t Log: 

Figure 3-2 Main Window for 13-lnch Monitor with Macintosh IIfx 
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Multiple-Product Diagnostics 

• System configuration information-including system 
software, AppleTalk, QuickDraw, and ROM versions; 
system and processor types; amount of system RAM 
and ROM; parity checking; amount of video RAM; 
date of manufacture; and the number of hours under 
power. 

• Selectable logic board tests-for components, system 
RAM, serial loopback circuitry, and video RAM. The 
logic board component tests examine Macintosh 
computers as follows. 

Tested on the IIfx. IIsi. and LC: 
ROM (read-only memory) chips 
SCC (serial communications controller) chip 
SWIM (Sanders-Woz Integrated Machine) disk 
drive controller chip 
VIA (versatile interface adaptor) chip 
SCSI registers 

Tested on the Macintosh IIfx: 
FPU (floating-point unit) chip 
ASC (Apple sound chip) 
FMC (fast memory controller) chip 
ass (operating system support) chip 

Tested on the Macintosh IIsi: 
RBV (RAM-based video) chip 
FPU (floating-point unit) 

Tested on the Macintosh LC: 
BIV (built-in video) chips 
CLUT (color look-up table) chip 

Tested on the Macintosh Classic II: 
VIA (versatile interface adaptor) chip 
SCC (serial communications controller) chip 
RBV (RAM-based video) chips 
ADB communication 

• Selectable tests of the internal and external floppy 
drives (external on the Macintosh IIcx, IIci, IIsi, and 
Classic II only) and of system-to-mouse Apple 
Desktop Bus (ADB) communications. 
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1.6/ MacTest MP 

- Tests for Apple video cards in the NuBus slots. 
Mac Test MP tests these Apple video cards: 

Macintosh II Monochrome Video Card 
Macintosh II Video Card 
Macintosh II High-Resolution Display Video Card 
Macintosh II Extended High-Resolution Display 
Video Card 
Macintosh II Two-Page Monochrome Video Card 
Macintosh Display Card 4 - 8 
Macintosh Display Card 8-24 
Macintosh Display Card 8-24GC (Before testing 
this card, be sure to remove 8 - 24GC INITs from 
the System Folder.) 
Macintosh II Portrait Video Card (Y ou must 
attach a monitor to the installed card. For the 
monitor test patterns to function, you must 
use a Video Card Expansion Kit (8 RAM chips) 
to upgrade the Macintosh Portrait Video Card.) 

- Tests for other Apple cards: 

Macintosh IIci Cache Card Revised 
- Apple lIe Card (Macintosh LC only) 

EtherTalk® NB Card (test works on the 
Macintosh II, IIx, IIcx, and IIfx-but not on the 
IIci and IIsi) 

- Test patterns for adjusting Macintosh monitors (select 
the Monitor icon and click Start). MacTest MP 
contains test patterns for adjusting the following 
Apple Macintosh monitors: 

Apple High-Resolution Monochrome Monitor 
- AppleColorTM High-Resolution RGB Monitor 

Apple Macintosh Portrait Display 
- Apple Two-Page Monochrome Monitor 

Macintosh 12-Inch Monochrome Display 
Macintosh 12-Inch RGB Display 
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o STARTING MACTEST MP 

Materials Required 

Test 
Setup 

Multiple-Product Diagnostics 

Macintosh IIfx, IIsi, LC, or Classic II (You can run 
MacTest MP on a Macintosh II, IIx, IIcx, or llci 
to test cards and monitors, but MacTest MP will not 
test the II, IIx, IIcx, and llci logic boards.) 

Macintosh monitor and video cable 
ADB keyboard and mouse 
MacTest MP diagnostic disk (backu p copy) 
Peripheral-B serial interface cable (required only for 

serial loopback test) 
Blank BOOK or 1.4 MB floppy disk (required only for 

floppy drive test) 

Note: Make a backup copy of the Mac Test MP diagnostic 
disk before you begin. When testing a defective system, 
you can damage or erase the disk. 

Note: If you plan to test system RAM or loop on tests 
including the RAM test, make MacTest MP the boot disk 
and application. Select the MacTest MP Application icon, 
select Set Startup from the Special menu, and click OK. 
You must unlock (write-enable) your MacTest copy. 

If you need more information, refer to the appropriate 
Macintosh Owner's Guide. 

1. Connect AC power cords from an AC outlet to the 
computer, and from an outlet to the monitor. 
Connect the keyboard and mouse to the computer. 

2. Connect the video cable to the monitor. Connect the 
the video cable to the Macintosh external video 
port or the connector on the Macintosh video card. 

3. If you want to run the serial loop back test, connect 
the serial cable between the printer port and the 
modem port. 

4. Insert a copy of the MacTest MP disk into the right 
or left internal (or external) drive and switch on 
system power. 

5. Double-click the MacTest MP icon and the Mac Test 
MP application. (If you followed the instructions in 
Materials Required to adjust Set Startup, skip this 
step.) 
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o OPERATING MACTEST MP 

System Configuration 
Infonnation 

1.8/ MacTest MP 

Figure 3-3. The main window area displays a variety of 
useful information concerning the hardware and 
software configuration of the system under test. Before 
running the tests, verify that the information is 
accurate. 

System vers: The version of the system software in the 
System Folder on the startup disk. 

AppleTalk vers: The version of AppleTalk (if the 
computer is connected to an AppleTalk network). 

QuickDraw vers: The version of QuickDraw in the 
System Folder on the startup drive or in ROM. 

ROM vers: The version of firmware in the system ROM 
chips. 

System type: The type of Macintosh computer that is 
running MacTest MP. 

Parity: Not available for MacTest MP. 

CPU/FPU type: The type (68000, 68020, or 68030) of 
central processing unit (CPU), and the type of floating­
point math coprocessor (FPU) (if installed). 

Video RAM size: The amount of RAM in the video RAM 
banks. To obtain the video RAM size of video cards, 
double-click the Card icon. 

ROM size: The amount of ROM in the computer. 

RAM size: The amount of RAM in the main RAM banks. 
On the Macintosh IIsi and IIei, some RAM can be for 
video. 

Power-on hours: The number of hours that the 
computer has been powered on since manufacture. 

Note: When you clear parameter RAM, the power-on 
hours revert to zero and the production 
date disappears. On the Macintosh II, power-on 
hours remain at zero. 

Production Date: The computer's date of manufacture. 
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Macintosh Test 
Selections 

Figure 3-3. Select Macintosh Tests allows you to select 
the tests you want to run. To select a test, click the 
box next to the name of the test. An X appears in the 
box. To deselect the test, click the box again and the X 
disappears. If a selection is dimmed, the test is not 
available. The following section explains each test and 
describes special requirements. 

MocTesP'" MP 2.0 

- - -- -Jllillimll il 
-~ 

Syatem yera: 1.0.1 Sy.te .. type: Hlc;n1Dah IIfx ROH.ize: 512 KB 

4MB AppleTal k W'lIra: ~ot Open8d Pa.-ity: Not 4vaileblt IMH 8izl: 

QuiekDr8'J vers: 2.2 Pover-on blllurs: 0 

RON vers: 67c.l1f2 

{:PUJFPU t"pe: 68030 I 68882 

Vide. RAN Size: Not Available Pr.ductiol Date: 10/9/91 

SeJel:t JdrlCintlOsh Tests Select Other Tests 

Log1c OOanl 

~ comp>nellt te,t3 

~ RAM te~t 

~ Ser;al laapbeclc 

flo, py Drive, 

l8J Rlgllt 

~ Left 

AD B Port -----. 

t8J Mouse 

!not 1: ~ Mec1n1Xl31l11 H1gh Re301utlon V1deD 
Card 

Slot Z: ~·--tSl nec1nt>31l11 MDoocllrome V1deo 
Card 

Slot 3: 

Slot 4: 

Slot 5: 

Slot 6: 

Test Log: 

Figure 3-3 Main Window for 12-lnch Monitor with Macintosh IIfx 

Logic Board 

Multiple-Product Diagnostics 

The logic board tests are divided into the following 
selections: 

Component tests - Tests all logic board circuitry and 
most components. Refer to Features under "Introduction 
to MacTest MP" for a complete list of logic board 
components and circuits that Mac Test MP tests. 

You can separately select data transfer tests for the 
serial interfaces. 
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1.10/ MacTest MP 

RAM test - Performs a test of the system memory 
indicated by RAM size. The test takes thirty seconds 
per megabyte and reboots the system afterward. 

IMPORTANT: To run the RAM test, you must unlock 
(write-enable) your copy of the MacTest disk. 

Video RAM test - Tests the VRAM (video RAM) chips 
on the 68-pin VRAM SIMM (Macintosh LC only) or on 
the video card. Video RAM size indicates the amount of 
VRAM memory tested. (This test is not applicable to 
the Macintosh Classic II.) 

Serialloopback - Tests the two serial interfaces by 
performing a series of bidirectional data transfers 
between the modem and printer serial ports. This test 
requires a peripheral-8 serial cable between the modem 
and printer ports. 

Screen patterns - Displays test patterns for the 
Macintosh Classic II only. 

To display the monitor test patterns: 
Click the Screen Patterns box under Logic Board 
tests. 
Click Start. 

To move forward through the test patterns: 
Press the Space bar. 
Press <S hift> <±.>. 
Click the mouse. 

To return to a previous test pattern: 
Press <Option> and click the mouse. 
Press <Hyphen>. 

Note: In the backward direction you can loop through 
the five test patterns as many times as you wish. 
However, in the forward direction the main window 
appears after the fifth pattern. 

Right/Internal and Left/External - Perform a write/ 
read/verify test of the right and left (optional) internal 
800K and 1.4 MB Apple SuperDrive disk drives. 
Right/Internal and Left/External examine floppy drives 
connected to the external disk drive port on the 
Macintosh IIsi. Use a formatted 1.4 MB floppy disk 
with at least 27K available. 
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ADB Port 

Other Test 
Selections 

Monitor Test Patterns 
(except Classic /I) 

Multiple-Product Diagnostics 

Mouse - Tests the Apple Desktop Bus (ADB) circuitry 
by establishing communication with a known-good ADB 
keyboard and mouse. Note that this is not a test of the 
mouse itself. The mouse test checks only for 
communication between the mouse and computer. 

Use Select Other Tests (see Figure 3-3) in the MacTest 
MP main window for the Macintosh Ilfx, IIsi, and LC 
(the Macintosh Classic II main window has no Select 
Other Tests) to identify and test Apple video cards. If a 
card is in an expansion slot and MacTest MP recognizes 
the card, a Card icon and name appear next to the slot 
number. Otherwise the message Unfaluiliar Card 
appears. If MacTest MP does not test the card, the Card 
icon dims. If a slot is empty, no icon or card name 
appears. 

For additional information about a card, double-click on 
the slot number, Card icon, or card name. 

To display test patterns for the Macintosh Classic II, 
see Screen Patterns under Logic noard (above). For the 
Macintosh IIfx, Ilsi, or Le, the Select Other Tests area 
of the main window enables you to adjust monitors 
connected to the system's built-in video port (BIV) or to 
a video card. To display the test patterns, select the 
appropriate Monitor icon and click Start. You can 
access additional information about the selected monitor 
or the test patterns by double-clicking BIV or the 
Monitor icon. 

To display the monitor test pallerns: 
Select the Monitor icon. 
Click Start. 

To move forward through the test patterns: 
Press the Space bar. 
Press <Shift> <±.>. 
Click the mouse. 

To return to a previous test pattern: 
Press <Option> and click the mouse. 
Press <Hyphen>. 
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Setting Looping 
Options 

Setting Preferences 

1.12/ MacTest MP 

Note: In the backward direction you can loop through 
the six test patterns as many times as you wish. 
However, in the forward direction the main window 
appears after the sixth test pattern. 

The looping options in Mac Test MP allow you to test 
modules repeatedly. Use looping to isolate intermittent 
or nonimmediate failures. Looping provides two 
choices-setting a specific number of times to repeat 
the selected tests, or looping until you give a stop 
signal. Setup Looping is under the Options menu. 

If you loop on the RAM test, you must unlock (write­
enable) your copy of the MacTest floppy disk. 

If you loop on the RAM test, MacTest MP automatically 
reboots the computer at the end of each pass. The 
MacTest MP program automatically reboots if Mac Test 
MP is the startup disk and startup application (see the 
note under "Starting MacTest MPII). For several seconds, 
MacTest MP displays the test results. During this 
display you can stop the looping. If you do not stop the 
looping, MacTest MP runs another RAM test. 

Note: When you run the RAM test, MacTest MP saves 
the current selections, and the previous selections 
disappear. 

You can customize MacTest MP test logs to include 
service center and customer information, system 
configuration, and a time stamp. Customize test logs by 
selecting Preferences from the Log menu. However, 
the Log menu is deactivated (dimmed) unless a test log 
is open and selected (the log is the front window). 

To begin a new test log, select New from the File 
menu. To select an existing test log, click the Log icon, 
use Open to select a saved test log from the File menu, 
or select an open log from the Windows menu. With 
the desired test log open on your screen, select 
Preferences from the Log menu. You can now enter the 
service center and customer information, and set test 
log options. Figure 3-4 shows the Test Log Preferences 
dialog box. 

Note: When you close the log, dealer information saves 
as a default, but customer information disappears. 
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Show in Test Log: Test Log-2 

181 Dealer Information 

~ Customer Information 

t8J System Configuration 

t8J Time/Date 

Dealer Information: 

Sam & Davels Mac 
Shop 
1500 Studio Plaza 
Land 10 Lakes, WI 
53121 I 

10 

Customer Information: 

Doug Jones 
11 Riverfront Drive 
Land 10 Lakes, WI 
53121 

[Cllncel) ~ 

) Figure 3-4 Test Log Preferences Dialog Box 

) 

Using the Controls After selecting tests, setting preferences, and choosing 
looping options, you can start testing. Activate the 
following controls by clicking: 

Multiple-Product Diagnostics 

• Start - Runs the selected tests. 

• Stop - Terminates the testes) in process. 

• Pause - Temporarily suspends the tests. Click 
Pause again to resume testing. 

• Log - Turns the display of the test log window on 
or off. If no open log exists, a new log appears. 

• ? icon - Contains additional information about the 
test failure. When MacTest MP has no additional 
information, the icon is dimmed. 

• Loop - Indicates whether looping is ON (the 
circular, Looping Arrow icon highlights) or OFF (the 
circular arrow is white/clear). A loop counter is 
beneath the icon. 
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As the Tests 
Are Running 

The Status line at the lower-left corner of the main 
window indicates the progress of MacTest MP. You can 
temporarily suspend tests by clicking Pause. You can 
end tests by clicking Stop or typing X - <Period>. 

Note: During the RAM test and video card tests, the 
mouse and keyboard do not operate. The RAM and 
video card tests must run to completion. 

If Mac Test MP finds no problems, it displays the 
message All Tests Passed. 

If MacTest MP encounters a problem, the test stops and 
displays an error message on the Status line and in the 
test log. If MacTest MP has more information, the 
Question Mark icon highlights. Click the question 
mark for assistance. If information from MacTest MP 
doesn't correct the problem, refer to Section 4, 
Troubleshooting, of the Apple Service Technical 
Procedures for the Apple product you are testing. 

o MACTEST MP REFERENCE 

Quick Reference 

1.14/ MacTest MP 

To set up and run MacTest MP, follow the steps below. 
Detailed procedures are under "Operating MacTest MP." 
Remember to use a copy of MacTest MP and to use Set 
Startup to automatically open the MacTest MP 
application. 

1. Set up the Macintosh IIfx, IIsi, LC, or Classic II. 
You will need a video monitor, video cable, 
keyboard, and mouse. You may need a video card. 

2. Connect a serial loopback cable if you plan to run 
the Serial Loopback test. 

3. Insert the MacTest MP disk in the right (or left) 
internal or external disk drive. Switch on the 
computer. 

4. If the desktop appears, double-click the MacTest MP 
disk icon. 
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Menus and 
Keyboard Equivalents 

) 
Apple Menu 

File Menu 

) 

Multiple-Product Diagnostics 

5. Double-click the MacTest MP application. 

6. Verify that the system configuration information is 
correct. 

7. Select the tests you wish to run. 

8. If you desire, select Setup Looping under the 
Options menu. 

9. Click Start. 

10. Click Stop or Pause. 

11. Print and save the test log. Use Preferences under 
the Log menu to enter service center and customer 
information. 

12. If a test fails and the Question Mark icon 
highlights, click the icon for information. 

The MacTest MP menus and menu selections appear 
below. Keyboard equivalents are indicated. 

The Apple eti) menu contains the following selec;tion: 

About MacTest MP - Displays a dialog box that shows 
the diagnostic name and version number. 

The File menu contains the following selections: 

New ex -N) - Creates a test log that will be current 
until you close it, create a new log, or open another. 

Open ex -0) - Opens a saved test log. You can open 
a saved test log for display, printing, or appending. 

Close ex -W) - Closes the current test log. If you 
haven't saved the contents, a dialog box will appear. 

Save eX -~) - Displays a dialog box that asks you for a 
file name to save the test log contents. 
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Controls Menu 

1.16/ MacTest MP 

Save As - Displays a dialog box that asks for a file 
name. MacTest MP saves the log under the new name. 

Revert to Saved - Opens the most recently saved test 
log. 

Save Selections - Saves the current test and looping 
selections. 

Page Setup - Displays the printer Page Setup dialog 
box. See the Macintosh System Software User's Guide. 

Print (3€ - E) - Prints the active test log to the printer 
selected in the Chooser. 

Quit (3€ - Q) - Terminates the program and returns to 
the FinderTM (desktop). 

Eject (3€ - ID - Ejects the right floppy disk or internal 
floppy disk. 

Eject Left (3€ - £) - Ejects disks from the left floppy 
drive or external floppy drive. 

The Controls menu contains the following selections: 

Start (3€ - G) - Runs the selected logic board and 
peripheral tests. 

Stop (3€ - <P e r i od» - Terminates the testes) in 
process. 

Pause (3€ - <Apostrophe» - Suspends 
(dark/highlighted button) the test in process. Click 
Pause again to resume testing (light button). 

Log (3€ -!J - Displays (dark/highlighted button) or 
hides (light button) the contents of the current test log. 

LoOp (3€ - I) - Switches looping on (dark/highlighted 
button) or off (light button). 

? icon (3€ - Y) - When the icon is highlighted, MacTest 
MP has information about test failures; click the icon. 
When the icon is dimmed, MacTest MP has no 
information. 
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Options Menu 

) 

) 

Windows Menu 

) 

Multiple-Product Diagnostics 

The Options menu contains the following selections: 

Setup Looping - Displays the Looping Options dialog 
box shown in Figure 3-5. You can set the number of 
loops, or you can loop on the selected tests until you 
enter the stop command. 

Brightness - (Macintosh Classic n only) Lets you 
adjust screen brightness. (Refer to Section 3, 
Adjustments, of the Macintosh Classic and Classic II 
Technical Procedures.) To advance to the next 
brightness adjustment screen, click the mouse or Space 
bar. After the third screen, you will return to the main 
window. 

Shut Down - Quits MacTest MP and runs the safe 
shutdown sequence as if you had selected Shut Down 
from the Finder. 

@ Loop ~ time(s). 

o Loop until stopped. 

(cancel) liD) 

Figure 3-5 Looping Options Dialog Box 

The Windows menu contains the following selections: 

Main Window (3€ - M) - Brings the MacTest MP main 
window to the front and makes it the active window. 

Test Log I-x - If test logs are open, MacTest MP adds 
their names to the Windows menu. To bring a test log 
to the front (active window), select that test log entry 
from the menu. 
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Log Menu 

Illustrations Menu 

System Software 
Compatibility 

MultiFinder Compatibility 

1.18/ MacTest MP 

The Log menu contains the following selection: 

Preferences - Contains selections for induding the 
service center, customer information, system 
configuration, time, and date in the test log. 

Unless memory limitations dictate otherwise, the 
Illustrations menu displays drawings of Macintosh 
modules and video cards. 

Note: You must have 733K of available memory to run 
MacTest MP 2.0. This 733K provides enough memory to 
display the Macintosh LC, IIsi, or IIfx logic boards from 
the Illustrations menu; the other illustrations are not 
shown. If you increase the application memory size to 
1200K, all illustration's will become available. To 
increase the available memory, select the MacTest MP 
icon and choose Get Info ex -1) from the File menu. 
Under Application Memory Size (K), type 1200. Close 
the Get Info window. 

To run MacTest MP, you must use system software 
version 6.0.7 or later. The System Folder on the 
MacTest MP disk should not contain non-Apple startup 
or control panel documents, desk accessories, device 
drivers, or other system software modifications. Apple 
cannot guarantee the accuracy of test results for 
systems with third-party operating-system modifications. 

MacTest MP is MultiFinder® compatible. In fact, 
System 7 computers run MultiFinder only. 
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